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1 Create a Batch of Samples

1 Open MassHunter Q-TOF Quantitative Analysis 11.

(CQuant=h

2 Select the Project containing the data and PCDL(s).

Project *

Select project:

QTOF -

3 Create a new batch of data.
a Select New Batch.

Queue Vi

EIE

New | Open
Batch | Batch v v Edit Report Method

Report

o

Navigate to the folder that contains the data files (X:\Projects\QTOF\Data\MHQuant 11 Training
Data).

MassHunter Quantitative 11 Training data is included in the download. Store the data in the
appropriate folder under Projects.

¢ Enter a batch file name.

The example displayed is Quant 11 Training.

Quant_ll_Trainind

| Enable Audit Trail

PT! D:\Projects\QTOF\Data\MHCQuant 11 Training Data

Name Date modified ~
BlankStrawberry_2.d 4/11/2022 5:08:17 PM
Call_Z.d 4/11/2022 5:08:22 PM
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1 Create a Batch of Samples

d Select Create Batch.
The Add Samples window automatically displays. By default, all samples in the folder are already

highlighted.
Add Samples ? et
Batch Folder: D \MassHurter\Data*MHGuant 10.1 Training Data
File name Mame Sample Acq. Date-Time

Group

Strawbemy_sample_1.d | Strawbery_sample_1 1372018 814 A

Strawbemy_sample_2.d | Strawbemy_sample_2 /1372018 9:03 A

Strawbemy_sample_3d | Strawbemy_sample_3 A1372018 952 A
Strawbemy_sample_4.d | Strawbemy_sample_4 372018 10:42
Strawbemy_sample_5.d whermry_sample_5 A13/201811:

Strawbemy_sample_6.d whemy_sample_&

Strawbemy_sample_7.d whemy_sample_7

Strawbemy_sample_8.d | Strawbemy_sample_8 1342018 4:13 PRY

| Browse to Copy Samples... |

| Translate MSWS Samples... |

Select Al [ ok ]| cancel

4 Select OK to add samples.
The data displays in the Batch Table.

Batch Table
Sample: M S0ppb v % Sample Type: <All> = Compound: (
Sample

@ |v| Name ’ Data File Type |Level |  Acq DateTime

1ppb 1ppb.d Sample 11/16/2018 10:53 AM

B Sppb Sppb.d Cal 1 1116/2018 12:07 FM
B 10ppb 10ppb.d Cal 2 11/16/2018 1:20 PM
B 20ppb 20ppb.d Cal 3 11/16/2018 3:55 PM
D 50ppb S0ppb.d Cal 4 11/16/2018 5:09 PM
B 100ppb 100ppb.d Cal 5 11/16/2018 6:23 PM
B Blank Blank.d Sample 11/16/2018 6:19 AM
B Strawberry_sample_1  Strawberry_sample_1.d  Sample 11/13/2018 8:14 AM
B Strawberry_sample_2  Strawberry_sample_2d  Sample 11/13/2018 5:03 AM
B Strawberry_sample_3  Strawberry_sample_3.d  Sample 11/13/2018 9:52 AM

B Strawberry_sample_4  Strawberry_sample_4.d  Sample 1171372018 10:42 AM

B Strawberry_sample_5  Strawberry_sample_5.d  Sample 11/13/2018 11:31 AM
B Strawberry_sample_6  Strawberry_sample_6.d  Sample 11/13/2018 2:35 PM
B Strawberry_sample_7  Strawberry_sample_7.d  Sample 11/13/2018 3:24 PM
B Strawberry_sample_&  Strawberry_sample_8d  Sample 111372018 413 PM
: Strawberry_sample_9  Strawberry_sample_9.d  Sample 11132018 5:02 PM
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2 Build a Targeted Analysis Method from PCDL

Create a new method from PCDL

1 Within MassHunter, select the Method tab from the toolbar, then select New > New method from

Library - LC.
B8 - Agilent MassHunter Quantitative Analysis (for Q-TOF) - MHQuant10.1 Training Data - Pestici

~ Library Method
¥ Update v
New Method from Acquired Scan Data Method Setup Tasks

New Method from Acquired Scan Data with Library Search

Batch Tal

New Method from Acquired Chromatographic Data

: =
i Swonple: £ New Method using Manual Setup ~ | Compound: ¢ + % IsTD: =18
New method from library - GC
____________ ] Level j Acq. Date-Time
“New Method from CEFfile i 11/16/2018 10:53 AM
) - 1 111812018 12:07 PM |

The Method from Library — LC window displays.

Method from Library - LC o
Library:
Browse...
Workflow:
IS only -
Sample:

Sample path: {required for Q-RAI workflow)

Browse.__.
[] Updat= RT fram sample
Targets:
(® All compounds
() Use compound list
Browse__.
Qualifiers:
MNumber of qualifiers to add:
o
Candidate icn ranking:
MMost abundant -
Species
Choose...
0K Cancel

MassHunter Quantitative Analysis LC/Q-TOF Screener Method Development Using All lons and Q-RAI Data 6



2 Build a Targeted Analysis Method from PCDL

2 Inthe Library panel, select Browse... to navigate to and select the PCDL containing the target and/or
suspect analytes for the method.

+ If there is no RT in PCDL, the RT in the method will be left blank.
+ If there are no spectra, only a precursor ion will populate in the method. There will be no fragments.

+ If the method is intended for simultaneous quantitation and screening, Agilent recommends a
separate Target PCDL and Suspect PCDL. Targets are analytes with a calibration curve, and
suspects are analytes without a calibration curve.

3 Within the Workflow panel, choose the acquisition mode of the data to be analyzed.
* MSscanonly
+ Alllons
+ Q-RAI (Quadrupole resolved All-lons)
+ Targeted MSMS

4 Within the Sample Path panel, select Browse... to navigate to and select an example data file to help
build the method.

This is needed for Q-RAI to establish what quadrupole bands were used. For All lons, it helps define
optimal CE for analysis based on the CE used in acquisition.

For All lons, if there is a mismatch between CE in the acquisition and PCDL (i.e. 15 for the acquisition
method, but 10, 20, or 40 for PCDL), no fragments will be inputted, so leave this blank and manually add
the CE in the method editor.

5 Within the Targets panel, select a radio button to determine what analytes are used to create a method.
Select All Compounds to create a method using all the analytes in the PCDL.

Select Use Compound List to navigate to and select a subset of analytes using a compound list
* txt file.

6 Within the Qualifiers panel, enter the number of qualifiers to add to the method according to
their ranking.

It is best to begin by selecting more fragments, then filter down to the best fragments in the analysis
method optimization steps.

7 Within the Qualifiers panel, use the drop-down menu to choose how to rank candidate ions
for selection.

Candidate lon Ranking Meaning

Most abundance All candidate ions in the component
spectrum are ranked by ion abundance.

Weighted All candidate ions in the component
spectrum are ranked by mass weight
factor (MZ x MZ x Abundance).

Highest mass The candidate ions in the component
spectrum are ranked by m/z value.

Monoisotopic Only works for GC data. It uses
Monoisotopic field of library instead of
Mass field.

Candidate ion ranking offers control over the ion selection process while creating a new Quantitative
Analysis method from library. For LC data, it is mapped to the qualifiers only.

If there is a selectivity issue, try most abundant first, followed by weighted.
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2 Build a Targeted Analysis Method from PCDL

8 Inthe Species panel, select Choose... to navigate to and select the ion species for the analysis method.

When left blank, the ion species defaults to what is in the PCDL. If the PCDL has spectra for multiple
adduct types it will create multiple entries (duplicate compound names but with different precursor
ions). If one ion species is selected (i.e. [M+H]+), all analytes will have that precursor. If the PCDL does
not have spectra for the selected species, no fragments will be imported.

For a mixture of M+H and M+NH, ions in the method, either curate the PCDL with the preferred adduct
only and leave the species selection blank, or separate analytes in two PCDLs (or use a compound list)
and import the different adducts separately.

Here is an example of a completed Method builder dialog box for adding the Target analytes to the
method using All lons data (Target pesticide PCDL is located in the Training data folder).

Method from Library - LC x
Library:
D-\Projects\OQTOF\PCDLY Pesticides_6546_Targets_RT.CODB Browse...
Workflow:
Alllons A
Sample:

Sample path: {required for G-RAI workflow)

Browse...

[ ] Updats RT from sample

Targets:

i® All compounds
() Use compound list

Browse. ..
Qualifiers:

Mumber of qualifiers to add:

e
Candidate ion ranking:

Most abundant -

Species

(M-+H)+ Choose...
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2 Build a Targeted Analysis Method from PCDL

9 Select OK.
A Quantifier window displays.
Quantifier
Precursor Callision Eomw User
Name TS Transition | Scan Type b Productlon| RT lon Polarity Criteria Energy EDI'I;;gY Defined
> Methamidop 1 1420086  Scan Target 0.0000 142.0086 2.718 Paositive Close RT with 0.0 0.1
| Methomyl 1 1630636  Scan Target 0.0000 163.0536 3.097 Positive Close RT wath... 00 0.1 Targets
L Fenuron (... 1 165.1022  Scan Target 0.0000 165.1022 3.808 Positive Close RT wath.. 0.0 0.1 Targets
L IPC | Propha.. 1 180.1019  Scan Target 0.0000 180.1079 6.296 Positive Close RT with... 0.0 0.1 Targets

10 Label the analytes as Targets.
a Inthe method editor, navigate to and select Method Setup Tasks > Compound Setup.
b Right-click, and select to add a User Defined column.

In MassHunter Q-TOF Quantitative Analysis 11, there are instances of User Defined columns
numbered 1 through 9. However, in Compounds-at-a-Glance, there is only one available User
Defined Column, and it is not numbered.

¢ Inthe new column, label all analytes Targets.

d (Optional) Label the first row as Targets, then right-click and select fill down to duplicate the entry
down the column.
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Add Calibration Curves for Target Analytes

Set concentration levels

1 Within MassHunter, select the Method tab from the toolbar, then select Method Setup Tasks >

Concentration Setup.
4 Workflow
Target Deconvolution Setup
Screening - GC
Screening - LC
4 Method Setup Tasks

Compound Setup
Retention Time Setup

ISTD Setup

Build a Targeted Analysis Method from PCDL

Concentration Setup
Qualifier Setup
Calibration Curve Setup

[# Globals Setup
4 Save [ Exit

kel Validate

Save As...
B exit

P Manual Setup Tasks

Sample
Name | Data File ‘ Type Lev
2

— Add/Remove Columns... |
2 Add Column -
:

™= Remove Column
> L u E
B Restore Default Columns Far
| | Auto Fit Columns [ar
| [ar
Fill Down [ar
[ar
B Reset Sort o
| Arrange Compounds By Far
[ar
B New Compound -
B New Qualifier [ar
-’ New Calibration Level | Far
Delete [ar
[ar
B Duplicate Compounds Far
: Swap Qualifier With Quantifier [ar
Generate Qualifiers from Library - GC ... jat

2 Right-click any target analyte, then select New Calibration Level.

If Sample Type, Level, and Expected Concentration have already been set up in the Batch Table, select
Calibration Curve > Create Levels from Calibration Samples, then skip to step 7 below.

3 Repeat step 2 four more times for the same analyte to create 5 levels under that analyte.

4 Add level numbers (1 to 5) and their respective concentrations (5, 10, 20, 50, and 100 ppb).

Quantifier
MName | TS | Transition | Scan | Type |
=8 Methamidop.. 1 142.0086 Scan Target ng,
| calibration
Level | Conc. | Response | Enable
5.0000
10.0000
50.0000
100.0000
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2 Build a Targeted Analysis Method from PCDL

5 Right-click any of the levels and select Copy calibration levels to....

i iead St Add/Remove Columns...
Quantifier Add Column »
Name I T8 ] Tr " -
3 Methamidop. 1 14 CHIOVE Lo
e Restore Default Columns
Calibration 7
Level I o Auto Fit Columns
L1 5.0 Fill Down
- 2 10.0
» 3 Reset Sort
|- 4 50.0 Arrange Compounds By »
5 100.0
Quantifier New Compound
Name | T8 Tr New Qualifier
| Methomy! 1 161 New Calibration Level
Fenuron (N... 1 16¢
IPC | Propha.. 1 18( Delete
Acephate 1 18
_ Fuberdazole 1 18 Duplicate Compounds
Molinate 1 18¢ Swap Qualifier With Quantifier
S = = Generate Qualifiers from Library - GC ... —
»mpound Information Generate Qualifiers from Library - LC ...
AN AV ) oo e e e === b
M (142.0026) Scan 20ppb.d [ T —
10 “‘I Average Calibration Replicates...
2R

6 Click Select All to highlight all compounds, then select OK.

Copy Calibration Levels To X
Select Compounds:
Mame T5 RT Transition ISTD Fag Cmpd. Group Uzer Defined &~

Methomyl . 163.0536 Targets
Feruron (N N-Dimethyl-N-phenylurea) 857 | 1651022 Targets
IPC / Propham 2 1801019 Targets

Acephate 2. 18401592 Targets
Fuberidazole T 185.0709 Targets

Molinate 667 | 1881104 Targets

Propamocarb 2.809 | 1891553 Targets

Select Al OK || Cancel

7 Under Method Setup Task, select Calibration Curve Setup.
8 Make the following selections, as appropriate.

+ Select Linear for CF

+ Ignore for CF Weight

* 1/x for CF Weight.

Quantifier
Name | TS | Transition Scan Type CF CF Ongin CF Weight User Defined
Methamidaop.. 1 142.0086 Scan Target Linear Ignore 1 Targets
B Methomy! 1 163.0536 Scan Target Linear Ignore 1 Targets
[ Fenuron (N... 1 165.1022 Scan Target Linear Ignore 1= Targets
| IPc | Propha 1 180.1019 Scan Target Linear Ignore T Targets
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Build a Targeted Analysis Method from PCDL

Append the method to add the suspect analytes
1 From the Method tab of MassHunter, select Append > Append Method from Library-LC.

] =

File Home

[_'_\D ﬂI’ Append v r.% Method Report Method Setup Tasks ¥ Advanced Tasks ¥  Duplicat
Append Method from Acquired Scan Data
New

Open

Append Method from Acquired Scan Data with Library Search on Curve v
Append Method from Acquired Chromatographic Data Method 4

Append Method from Method File
Method Tasks

wend Method from Library - GC
T KRR EmO L) O —
P New /Open Method Append Method from Library-1C |

Compound: { | Me

D = L= Lo S =
Append Method from CEF File

p  Workflow
I

Nata Fila Tuna
2 Specify the appropriate selections in the Method from Library - LC window. Refer to steps 2 to 9

I MNama

in Create a new method from PCDL for instructions. However, in step 8, navigate to and select Suspect

PCDL rather than Target PCDL.

The method now contains targets and suspect analytes.

Method from Library - LC x
Library:
D:\Projects\QTOF\PCOL\Pesticides_6545_Suspects_RT_and_Spectra.cdb Browse.
Workflow:
Alllons it
Sample:

Sample path: [required for Q-RAI workflow)

Browse...

[ Update RT from sample

Targets:
® All compounds
(O Use compound list
Browse...
Qualifiers:

Number of qualifiers to add:

5[4
Candidate izn ranking:

IMost abundant -

Species

[M+H)+ Choose._._
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2 Build a Targeted Analysis Method from PCDL

3 Inthe method editor, label the suspects in the user defined column.
The suspects will have a blank User Defined column. Enter Suspects in that column.

Quantifier
Collision
Narme s | Transiion | Scan | Type | P™US |proguction| RT | fonPolarity Citeria CE"I']'S;“ Energy R
Delta
Avermectin.. 1 8734995  Scan Target 00000 8734995 15358 Positive Close RT with 00 0.1 Targets
| Ivermectin B 1 8755151 Scan  Target 0.0000 875.5151 16.646 Positive Close RT with 0.0 0.1 Targets
» Chloroproph 1 2140629 Scan Target 0.0000 2140628 7543 Positive Close RT wath 0.0 [RY Suspects
| Acrinathrin (. 1 5421397  Scan Target 0.0000 5421397 14.061 Positive Close RT with 0.0 0.1 Suspects
| Butoxycarbo 1 2230747 Scan  Target 0.0000 223.0747 2.814 Positive Close RT with 0.0 0.1 Suspects
Chiorflurazur. 1 539.9702 Scan Target 00000 539.9702 13.612 Positive Close RT with 0.0 0.1 Suspects

4 In the Criteria column, specify Close RT with Qualifiers for Suspects and Target analytes.

See PeakSelectionCriterion below for an explanation of additional potential criteria.

PeakSelectionCriterion

PeakSelectionCriterion represents the algorithm employed to select the peak which is designated the
hit, i.e. the PrimaryHitPeaklID. The criteria affect the mechanism of ranking the Peak rows associated with
this TargetCompound row. The most suitable Peak row is then chosen as the primary hit.

PeakSelectionCriterion has several possible values.

PeakSelectionCriterion

GreatestResponse

Close RT

Close RT with Qualifiers

Greatest Q-Value

Value

GreatestResponse causes the peaks (such that the Peak row) that exhibit the greatest
integrator-determined response to be designated the hit. For response, either height or area
will be used as indicated by the value of the QuantitateByHeight column. This is the default
value.

There is only one primary hit. Other non-hit peaks are considered alternative hits.

Close RT causes the ranking of the peaks such that the Peak row that exhibits the closest
integrator-determined retention time, irrespective of quality and fidelity of qualifier signal ratios
is designated the hit.

Other non-hit peaks are considered alternative hits.

Close RT with Qualifiers causes the ranking of the peaks such that the Peak row that exhibits
the best retention time among the Peak rows for which all qualifier ratio tolerances are
satisfied is designated the hit.

If there is no Qualified Peak row, this ranking algorithm will be equivalent to Close RT.

Greatest Q-Value causes the ranking of the peaks such that the Peak row that exhibits the
nominal qualifier ratios that are best satisfied by the actual ratios. A correlation computation
called QVALUE is performed to measure the fidelity of the observed qualifier ratios versus the
nominal qualifier ratios.

The definition of the QVALUE function is a well-defined statistic that yields an efficient
measure of the goodness of fit of the observed qualifier ratios to the nominal qualifier ratios.
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3 Create an LC Screener Method

LC Screener Workflows

Build an LC screening method by adding parameters for extracting the analytes, analyzing the data, and
flagging outliers.

For this application, there are different parameters for the Targets and Suspects. Other applications might
have the same parameters.
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3 Create an LC Screener Method

1 Within Method Tasks, select Workflow > Screening - LC.

Method Tasks - B %
[» New /Open Method

4 Workflow

Target Deconvolution Setup
Screening - GC
Screening - LC
The Setup Screening — LC screen opens to display default parameters.

Setup Screening - LC x

Apply ta:
(@ Allcompounds () Selected compounds

Pattern liprary:-

Browse._..

Setup Pattern Library... |

Reference library:

| Browse._.. |

Speactrum setug:

|:| Product lon scan as Spectrum Extraction Override (required for Target MEMS)

Sepctrum Extraction Override Collision Energy:

MMass extraction setup:-

Left m/z: | 100 Right m/z: | 100 Unit: | FFM -

Retention Time satup:

Left delta: | 1 Right delta: | 1 Unit: | Minutes
QOutlier setup:
RT Windaow
10 Unit:  Percent -
Min. 5/N

Coelution Score Limit

IMass Accuracy Limit

Mass Match Score Minimum

# of Werified lons Minimum

o

MassHunter Quantitative Analysis LC/Q-TOF Screener Method Development Using All lons and Q-RAI Data
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3 Create an LC Screener Method

2 To build a pattern reference library, select Setup Pattern Library..., then click to check (M+H)+,
(M+Na)+, and (M+NH4)+ adducts.

Setup Reference Pattern Library >

Create reference pattem library at:

| Data*\Pesticide Training_Allons Data pattem reflibrary xml Browse. ..

Choose species to generate spectra:

] M+ A
(M=H)

{M=Na}+

[] M+

L] M

(] -+

[] m<Cly

[ M+

[] (M+HCOO}

[1{M=CHAC00)- i

|(M+NH4) | || (X
Cance

3 Select OK.

The Library editor initiates and a pop-up progress window displays.

Setup reference pattern library

Adding compound Tribenuron-methyl

4 Select OK when the reference pattern library is complete.

Agilent MassHunter Quantitative Analysis ®

o Reference Pattern Library was created.

If a pattern reference library is not set up, the isotope abundance visualization (denoted by red boxes) will

not appear in the LC Screener Tool.

MassHunter Quantitative Analysis LC/Q-TOF Screener Method Development Using All lons and Q-RAI Data
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3 Create an LC Screener Method

5 On the Setup Screening — LC screen, use the radio button to select All Compounds.

Apply to:
(@ All compounds () Selected compounds

Pattern library:

D:\Projects\QTOF\Data\MHCQuant 11 Training DataDemo.pattern.reflibrary.xmi ‘ Browse.... |
Setup Pattern Library... |

Reference library:

‘ Browse._.. |

Spectrum setup:

|:| Product lon scan as Spectrum Extraction Override (required for Target MSMS)

Sepctrum Extraction Override Collision Energy:

Mass extraction setup:

Left m/z: | 10 Right mjz: | 10 Unit: | PPM A

Retention Time setup:

Left delta: | 0.4 Right delta: 0.4 Unit: | Minutes -
Qutlier setup:
RT Window
0.2 Unit: | Minutes -
Min. 5/

3
Coelution Score Limit
80
Mass Accuracy Limit
5
Mass Match Score Minimum
70
# of Verified lons Minimum

2

e

These are the parameters for the Target analytes.
6 Under Mass extraction setup, enter or select the following settings.

Parameter Setting
Leftm/z 10
Right m/z 10
Unit PPM
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Create an LC Screener Method

7 Under Retention Time setup, enter or select the following settings.

Parameter
Left delta
Right delta
Unit

Setting

0.4
0.4

Minutes

8 Under Outlier setup, enter or select the following settings.

Parameter
RT Window
RT Window Unit
Min. S/N
Coelution Score Limit
Mass Accuracy Limit
Mass Match Score Minimum

# of Verified lons Minimum

Setting

02
Minutes
3

80

5

70

9 Select OK once all settings have been entered.

10 Adjust the suspect parameters if the extraction or outlier parameters differs between targets and
suspects. Press Ctrl + Shift to select all Suspects in the compound table.

Method Table
Time Segment: ¢ | <Al ~| > Compound: € XMC/35% ~v| > ResetTable View
Quantifier
Name | 75 | Twmnson | Scan |  Type
Avermectin 1 8734995 Scan Target

[ Precursorlon | Product lon RT |

Ivermectin B.

1 8755151 Scan Target
211029 [sean UM
[ Femato (| —[502 1557 Towst

2

Tage

12
7

:

I N N -
w540 ot
PN ] PTTY e S YV

<

0.0000
|

0.0000 8734995

0.000¢ 5399702
0.000 384.0607
00001 3261784

0.000¢ 341.0342

11 Within Method Tasks, select Workflow > Screening - LC.
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3 Create an LC Screener Method

12 Fill in the following parameters in the Setup Screening - LC window. The differences between targets
and suspects are the selection of Selected compounds (under Apply to:) and the Retention Time
setup.

x
Apply to:
() Allcompounds (@ Selected compounds
Pattern library:
D:\Projects\QTOFData\MHCQuant 11 Training Data\Quant_11_Training.pattern.reflibr Browse._..

Setup Pattern Library...

Reference library:
Browse...
Spectrum setup:
|:| Product lom scan as Spectrum Extraction Override {required for Target M3MS)

Sepctrum Extraction Override Collision Energy:
Mass extraction setup:
Left m/z: | 10 Right m/z: | 10 Unit: | PEM -
Retention Time satup:
Left delta; | 2 Right delta: 2 Unit: | Minutes -
Qutlier setup:
RT Window
10 Unit: | Percent =
Min. 5/N
3
Coelution Score Limit
BO
Mass Accuracy Limit
5
Mass Match Score Minimum
70
# of Verified lons Minimum

2

oK ] Cancel

Enable SureMass

1 Convert the data to SureMass at the time of acquisition. It can be converted in one of two ways.
+ Select Acq 10.1 > Method > Post run script > SCP_SureMassConversion(){MH_Acq_Scripts.exe}.
+ Select Acq 11 > Method > DA Tab > Check SureMass box.

Conversion can be performed after acquisition in Quant 10.7 or higher by selecting Quant > Tools >
Convert Samples > MassHunter TOF/Q-TOF tab. However, Agilent recommends converting data at the
time of acquisition whenever possible.

The data represented in this guide has already been converted.
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3 Create an LC Screener Method

LC Screener Workflows

2 Enable SureMass analysis. Select Method Setup Tasks > Global Setup, then click to check the

SureMass box.
1arget ueconvoiumon >etup
Screening - GC

20ppb.d | 20ppb.d

. |Globals
Screening - LC Apply Multiplier to Matrix Spike ]
4 Method Setup Tasks Apply Multiplier to Surrogate %
Apply Multiplier to Target
Compound Setup Bracketing Type None
Retention Time Setup Correlation Window 0100
ISTD Setup Ignore Peaks Not Found O
Concentration Setup Library Method
- Non Reference Window 70.000
Qualifier Setup
o Non Reference Window Type Percent
Calibration Curve Setup Ref & Library
I [#’ Globals Setup Reference Pattem Library D:\MassHuntenData\MH_.ata. pattern. reflibrary xml
" Reference Window 80.000
4 Save [ Exit
Reference Window Type Percent
@& validate Relative ISTD O
Save r={Stamdardehdditten == == ==l == == == == =f] = I
Save As... ?;e&!ass & o
PPl = = = == == == == ===
Exit = U

MassHunter Quantitative Analysis LC/Q-TOF Screener Method Development Using All lons and Q-RAI Data
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3 Create an LC Screener Method
LC Screener Workflows

Add Peak Filtering

1 To adjust integration thresholding, select Advanced Tasks > Integration Parameters Setup.

4 Advanced Tasks

| Integration Parameters Setup

Signal to Noise Setup
Smoothing Setup
1l Mass Extraction Setup

Snectrum Fxtrartinon Setun

2 Double-click Integration Parameters to open the Integration box.

Integration ? »
Integrator General Universal Spectrum Summation Peak Fiter
P e mm om o ey Integrator:

L I I Int. Parms. I -mz v._

l Int. Pamms.

]

)

)

1]

t I Int. Parms.

| Int. Parms.

)

i)

J

)

(o1 e | oot | [t | [ oy

ST A
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3 Create an LC Screener Method

3 Select the Peak Filter tab, then select Peak Area, and adjust counts to 1000.

Integration ? X

Integrator General Universal Spectrum Summation Peak Fiter

Peak Threshold

(® Peak Area (counts) >= counts

(O Peak Height {counts) >= counts

O Peak Area (%) >= [ ] ‘oflargest peak
O Peak Height (%) 5= % of largest peak
(O Signal to Noise >= D

Maximum number of peaks

) Lk tothelages ok

[ oK J[ PResst || Defou || Cancsl | [ Aopl

4 Select Apply to All, then select OK.

If this step is skipped, there may be a significant number of analytes that need review with the LC
screener. These are false positives and this step removes a lot of analysis work.

MassHunter Quantitative Analysis LC/Q-TOF Screener Method Development Using All lons and Q-RAI Data



4 Apply the LC Screener Method to Data

1 Select Exit.
4 Save [ Exit

o4 Validate

Save As...
Exit

2 Apply the method to the batch and Analyze the data.

Apply Method >

? Would you like to apply this method to the batch?
@

fes No Cancel

Addtional batch processing after applying the method
® Analyze
() Quantitate
() Integrate

() None

MassHunter Quantitative Analysis LC/Q-TOF Screener Method Development Using All lons and Q-RAI Data
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Analyze Data Using the LC Screener

Update Calibrators

1 From the View Tab, select Compounds-at-a-Glance.
2 Select Setup Layout.

3 Remove all samples that are not Type Cal.

4 Select the Compounds tab.

Setup Graphics

Samples ||Compounds | Organize | Qutliers |

Compounds:

Name Type Transition RT -

Nicotine Target 163.1230
Cyromazine Target 167.1040
Butocarboxim... | Target 207.0798
Aldicarb sulfo... | Target 207.0798
Butoxycarbox... | Target .0747
Aldoxycarb (.. |Target .0747
Demeton-S-m... | Target 2470222
Demeton-S-m... | Target

Dicrotophos Target

Desmethyl-pir... | Target

Add > || Addais> <Remove

Compounds shown in this order:

<= Remove All

User
Defined

Suspects
Suspects

Suspects

Name Type Transition RT gzﬂi D gz:rr]ed
Dioxacarb Target 2240977 3743 Targets
Diniconazole(l) | Target 326.0821 11181 Targets
Benzoximate | Target 364.0946 10933 Targets
Trichlorfon (D... | Target 256.9299 3.837 Targets
Pirimiphos-m... | Target 306.1036 10.925 Targets
Metrafenone Target 409.0645 11.073 Targets
Metamitron Target 203.0927 3847 Targets
Dimethoate Target 230.0069 3770 Targets
Tolclofos-met.. | Target 300.9616 10.875 Targets

Maove Up Maove Down
‘ <Back | ‘ MNext > | | Apply | | 0K | | Cancel

5 Sort the list by User Defined.
6 Remove Suspects to focus on Targets.

MassHunter Quantitative Analysis LC/Q-TOF Screener Method Development Using All lons and Q-RAI Data
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Analyze Data Using the LC Screener

7 Select Fill Peaks on the Organize tab.

Setup Graphics

Samples | Compounds ||0rgamze | Qutliers |

Organize Rows by: Review Mode
(O) Compounds (@ None
@ Samples () Sample by Sample

T () Compound by Compound

() None - target anly O Compound Group by Compound Group

() None - target and qualifiers Pane Dimension

(@ Qualifiers 5x5 ™

Q181D Display Options

(O Matrix Spike [[] Wrap Rows

(") Compound Groups Baselines

O Sample Groups Fill Peaks Ik
() Compounds ] Normalize

() samples [] Uncertainty Band

Peak annotations...

<Back Next > Apply Cancel
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5 Analyze Data Using the LC Screener

8 Select Retention Time and Signal To Noise Ratio on the Outliers tab, then select OK.

Setup Graphics X

Samples | Compounds | Organize ||0uﬂ\ers |

ElM Peck Resu R
[JAttenative Peak

Capacity Factor

# of Verified lons

Peak Not Found

Peak Resolution Front

Peak Resolution Rear

Plates

QValue

SureMass Ratio

Retention Time

Relative Retention Time
Integration Metric

Symmetry

Full Width Half Maximum

Purity

Signal To Noise Ratio L\\,
Limit Of Detection

Limit Of Quantitation

Method Detection Limit

alifier

Qualifier Coelution Score
Qualifier Peak Not Found
Qualifier Peak Resolution Front
Qualifier Peak Resolution Rear
Qualifier SureMass Ratio
Qualifier Signal To MNoise Ratio
Qualifier Ratio

Qualifier Integration Metric
Qualifier Peak Symmetry
|_|Qualifier Peak Full Width Half Maximum hd

I

m
I I =g |

Filter:
(@ Show all panes

() Show panes without outliers

) Show panes with outliers

<Back Next > Apply Cancel

MassHunter Quantitative Analysis LC/Q-TOF Screener Method Development Using All lons and Q-RAI Data
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Analyze Data Using the LC Screener

9 On the View ribbon, select Link X Axes.

Baselines Link X Axes Link All X Axes

Fill Peaks Link Y Axes Link All ¥ Axes

Link Y Axes Vertically
Link Axes
[Diniconazole(l)]
x10 4 |226.0821

0.0400
9.038!

x10 8|
14

n =2

Manual Integration

Fit to Peak

Fit to Peak Height

Compounds at-a-Glance - MHQuant 11 Training Data - AE Training.batch.bin

Fit to Highest Calibration Level

Scale

[Benzoximate]

x10 4

364.0946 Area=
199.6157 An

n |183.992MArea= |

[Benzoximate]

x10 37
0.5+

n

364.0946 Area=...

183.9922p8rea=J.

[Dioxacarb] [Diniconazole(l)]
x10 6[224.0917 Arga=... %10 5 [326.0821)\Area=...
1 |167.0703 A: 1 O.Mﬂﬂﬁeaa..
n [123.044] AfeB= ~ |339.0389 Area=
[Dioxacarh] [Diniconazole(l)]
x10 8| %105 |

1

%105 ]

x10 84

[Benzoximate]

x10 3

i

364.0946 Area=...
198.0157 Area=
i iggzﬂrg_améﬂ

[Benzoximate]

%103 |

n

364.0946 Area=...
199.0157 Area=

¥839925fren=rn

[Benzoximate]
364.0946 Area=...

x10 34
24

n

_A__ Fit to Lowest Calibration Level Auto Scale All Panes

[Trichlorfon (Dylox) (DEP)]
x10 472569299 Area=...

0542209532 {4rea=
~ |109.005 mea_:ﬂv
[Trichlorfon (Dylox) (DEP)]
x10 4-256‘929%Area:...

12209532 |4rea=

- 1[}9.0054 ea=

[Trichlorfon (Dylox) (DEP)]
xm4_256‘929j

220953
~ [109.005
[Trichlorfon (Dylox) (DEP)]
x10 5'256‘929$Imea:...
0‘5,220.953% rea-
~ |109.005 &eazﬁ
[Trichlorfon (Dylox) (DEP)]
x10 5(256.9299 Area=...

Area=...
|Area=
cas,

142209532 |Area=
n [102.005] Wea=
28N 400

Lock Panes

[Pirimiphos-methyl (Pirimif...
%10 5306.1034 Area=...
164.118p| Area=...

0.5

n
[Pirimiphos-methyl (Pirimif...
x10 3 [306.103§ Area=...
I}:\,
[Pirimiphos-methyl (Pirimif...
¥10 5 [306.103f Area=...
1164.11

n
[Pinmiphos-methyl (Pirimif...
%10 5 [306.103§ Area=...

n
[Pirimiphos-methyl (Pirimif...

¥x10 6 [306.103§ Area=...
11641188 Area=...

10 Review and correct integrations.

Update Target Qualifier Ratios

1 On the Method ribbon, select Edit.
2 Select Update > Average Qualifier Ratios.

P13 L0010 000 AN

113/2018 9:52 AM
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5 Analyze Data Using the LC Screener

3 Select the User Defined heading to sort the table by that column.

Average Qualifier Ratios X
Select Compounds:
Namie TS RT Transttion ISTD Fag  Cmpd. Group User Defined - ™
Spinosyn D 1 746.4838 | | Targets
Avermectin Bla (Abamectin Bla) 1 873 4995 | | Targets
lvermectin Bla 1 892 5417 | | Targets
Famoxadone 1 352 1605 | | Targets
Chloropropham (Chlompropham) 1| 7.543 | 214.0625 O Suspects
Acrinathrin (Rufast) 1| 14.061 |542.1357 ] Suspects
Butoxycarboxim 1| 2.814 |223.0747 O Suspects
Chlorflurazurone (Chlofluazurone) 1| 13.612 |535.5702 O Suspects
Cimid, mdbead 4 AE EQE 304 ACAT 1 £, =y 7

Calculation Includes:

Cals
[ acs

][ wos

4 Highlight all Targets.
5 Select Cals under Calculation Includes:, then select OK.
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The LC Screener displays.

Perform Rapid Bulk Data Review
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After analyzing the batch, perform data analysis in the traditional manner using Quant software (similar to
MRM methods). However, when evaluating hundreds of analytes this can be time consuming and
inefficient. Use the LC Screener for rapid data review based on the outlier parameters stated above.

1 Select Tools > Screening LC to navigate to the LC Screener.

Adjust the screens as necessary. If only one monitor is available, Agilent recommends the split-screen
feature in the classic Quant-My-Way Ul screener tool, as shown below. Drag the Screener to the right
side of the window until it automatically fills that space.
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6 Perform Rapid Bulk Data Review

3 Adjust the information displayed in the Quant-My-Way user interface. This maximizes the pertinent
information displayed in the Quant-My-Way Ul and complements the LC screener information. Agilent
recommends the following adjustments.

* Delete unnecessary columns.
+ Add the mass accuracy column for the fragment ions.
+ Add the fragment chromatograms to the Compound Information.

+ Add the co-elution score to that plot. Right-click in the qualifier window, then select Properties >
Compound Information (2), then select Show co-elution score.

Batch Table v 2 X
Sample: # | 20ppb ~ % Sample Type: <All> ~ | Compound ( Aminocarb - > ISTD: |X Fxs -
Sample Aminocarb Results Qualifier (122.0.. | Qualifier (137.0.. | Qualifier (:1EI:A
m | v MName 4| Type | Level RT |Resp. gci;ﬁcl_ Accuracy Achgflfﬁscy Ratio Achgﬁfﬁscy Ratio Achgﬁfﬁscy Ratio Ach‘;lﬁi
Compound Information r 1 ¥
2ot AL AV COIRBRAWSE S ER p A A AL
+ ESM (205.1285) Scan 20ppb.d 205.1285 | 122.0600 , 137.0835 | 15z 1070 |, 126.0757
Z %103 2.817 min. 32 =102 Ratio = 82.1(3427% JCoelutlon Score = 99.4
2 1.4 = Ratio = 177.1 [1[]4 0 %) £oelution Score = 99.0
= 2 114 Ratio=36 0 100. 3 W) u}elutlcn Score =
1.2+ -E 1 Ratio = 34 7 (92.0 %) Cqgelution Score = 99.3
1.1 : z ]
1 E 0.3
0.5 ; % 0.8+ I
0.8- i = 07 ||
0.7 06 i”
0.6 054 ‘ |
0.5 . 0.4 |
0.4 0.3 |
0.3 : 02 \
0.2 : 4
0.1- 01 J .
- . o —-—
0.1 i -0.14 :
T T I — T T T T T R R T T T
25 26 27 2B 2% 3 21 25 26 27 2B 2% 3 31
Acquisition Time (min) Acquisition Time (min)
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6 Perform Rapid Bulk Data Review

A Target analyte in the Quant-My-Way Ul will have signal for the calibration spiked samples.

Number Formats

‘Convert Accurate Mass Samp

Tools

Batch Table
Sample: A 10pph

Method

New method from library - GC

Screening
GC

Screening - GC

T % Sample Type:| <All>

= Compound: €

New method from library - LC

Screening - LC

Aminacart

Show Log
Show Log Folder

Log

- X

|3 e i R EEE

Sample Aminocarb Results Quslifier (122 _ | Qualifier (137.08 | Qualifier (152.1._ | Qualifier | A
4] ‘ 4 ‘ MName 2 Type ‘ Level RT ‘Resp ‘ gcl’nzl ‘Accuracy Accuracy Ratio Ay:i?ascy Ratio Accifacy Ratio Acc‘:facy Ratio Achn
@ ¥ 5ppb Cal 1 2814 902. 32398 648 02514 814 -15264 1394 0.4764 105. -1.1568 394
» o 10ppb Cal 2 2816 187- 10.0379 1004 -05832 936 -0.5536 189.0 02669 97.0 -0.9130 345
[ o 20ppb Cal 3 2817 355 21.7340 108.7 0.0474 921 09017 1771 04631 960 0.3151 347
| @ ¥ Soppb Cal 4 2820 766.. 505018 101.0 -00541 §77 -0.1361 1704 16412 958 -0.0432 378
[ 0 ¥ 100ppb Cal 5 2218 146. 99.4865 995 08936 927 1.1899 1304 24408 929 1.2000 37.0
| @ ¥ Blank Sample 2753 3331 0.0000 -1.5130 60.5 41707
[ 0 ¥ Strawberry_sample_1  Sample 2588 1165 0.0000 00779 23. 00251 115. -0.6637 86.1 -0.7857
[ o v Strawberry_sample_2  Sample 2754 2568 0.0000 -2.6896
| o ¥ Strawberry_sample_ 3  Sample 2770 1603 0.0000 37264
[ o ¥ Strawberry_sample_ 4  Sample 2562 1610 0.0000 0.3913 b2
- @ ¥ Stawbery_sample 5 Sample 2768 1160 0.0000 1.0931
@ ¥ Strawbery_sample 6 Sample 2745 3978 0.0000 0.2377 155.. -1.2027
@ ¥ Strawbery_sample_7  Sample
: @ ¥ Strawbery_sample_8 Sample 3005 5292 0.0000 1.0474 435 43998 3. 0.2770 v
<[ >
Compound Information - B Calibration Curve - X
Rt AL AV YR ALE S iz 2 et . &> Type: Lnear -
S (2091285 Scan T0peb.d ) 2091265 1220600 , 1370235 , 1521070 12 Aminocarb - 5 Levels, 5 Levels Used. 5 Points, 5 Points Ussd, 0
£ x104 281min = «107] 9 %1057y = 14316 538170 " + 43843737205
H 74 @ x10
S L & 12 £ 5| 2~ 059090061 _
654 = 2 144 Type:Linear, Origin:lgnore, Weight:None
64 H i
554 -
5 =
454 =
4]
354
34
254
24
154
14
05
04
0.5
L O S F F S P—| LIS PR S S S R — T
25 26 27 28 29 3 2 25 26 27 28 29 3 31 § 10 2 2 40 %0 € 70 % % 10
Acqguisition Time (min) Acquisition Time (min) Concentration (ng/ml)
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6 Perform Rapid Bulk Data Review

A suspect analyte does not have a signal appear in calibrators.

Batch Table

- & X
Sample: # | 20ppb v & Sample Type: <All> | Compound: ¢ | Nicotine R 21 =
Sample Nicotine Results Qualifier (130.0.. | Qualifier (117.0.. | Qualifier (84 4
Final Mass . Mass . Mass ; Ma:
] ‘ ¥ ‘ Name | Type | Level RT ‘Resp.‘ Bire Accuracy Accuracy Ratio Accuracy Ratio Accuracy Ratio Faail
__ O ¥ 5ppb Cal 1 2180 8503 -0.8055 23 0.
O ¥ 10ppb Cal 2 2171 3493 -2.7724 506 -1.2125
» O ¥ 20ppb Cal 3 2198 4538 -2.2474 762 0.3486 45.0 -5.4561
O ¥ 50ppb Cal 4 2199 44387 -3.9274
__© ¥ 100ppb Cal 5 2195 4255 -1.6004 593 -0.5252
| @ ¥ Blank Sample 2215 2656 -2.3043
| @ ¥ Strawberry_sample_1  Sample 2202 101 -3.4096 269 55549 439 -1.6314
- @ ¥ Strawberry_sample_2  Sample 2202 127 -2.8565 40.3 0.5094
| @ ¥ Strawbery_semple_3  Sample 2210 8286 67037 358 6.3621 467 2.2666
| @ ¥ Strawbery_semple_4  Sample 2210 7998 -2.5941 279 0.9353
__ © ¥ Strawberry_sample 5  Sample 2235 127 00783 394 1.3958
__ © ¥ Strawberry_sample 6  Sample 2174 147, -1.0600 229 26835 297 -1.3171
O ¥ Strawberry_sample 7  Sample 2175 154, -0.4230 3838 54413
|| @ ¥ Strawberry_sample_8  Sample 2257 6910 -1.7485 294 -4.0916 292 -6.4325 ©
|< >
Compound Information - 13X Calibration Curve v 31X
e EAL AV EOIBRAWLES® 04 AR AAL . Taet ei¢ > et -
+ ESM (163.1230) Scan 20ppb.d 163.1230 . 130.0651 . 117.0573 . 84.0808 , 132.0808 - . - - -
2 03 T 104 Ratio =78.2 (7615 %) Chelution Score =507 Nm\oﬂtmen:ﬂ Levels, 0 Levels Used, 0 Paints. 0 Points Used
Z 3754 El Ratio = 45.0 (449.7 %) Chelutich Score = 33.0 g <07
= 15 S 171 Ratig = Coelution Scorei= 5 -1
< 14 Ratio = Coelution Scorgi= 2 144
325 z £ 13
34 Z 09 1
2751 £ 08 1.2
254 T 07 1'1 1
2254 1 1
24 be 0.3
1754 051 0.8
154 041 074
1254 0.34 0.64
14 024 1 0.5
0.75+ 0.1 ﬁl_‘l LA 0.4
0.5 o] : b ".'.ﬂ‘.’ .-ll'.‘-'ru L 034
021 ol h 021
04 H H H v 0.1
] NN o]
T T T T T T T T T T T T T T T T T T T T T T
05 1 15 2 25 3 35 4 05 1 15 2 25 3 35 4 b4 s 4 & b
Acquisition Time (min) Acquisition Time (min) Concentration (ng/ml)

The Screener displays compounds in a sample and assigns them a status based on the outlier
parameters set in the method. The green check means it passes all criteria, the orange means that the
data needs review because there is an outlier in the criteria, and the red means that it is negative.

The Screener has five main screens. The top panel contains all the analytes and their status. When an
analyte is selected in the Screener, it will display that analyte in the Quant-My-Way Ul automatically. The
middle left is an averaged spectrum of the full san (CE = 0) at the analytes RT, the middle right is the
isotopic profile of the real data (blue) compared to the theoretical (red boxes). If a Pattern Reference
Library was not created in the LC Screener Workflows step 2, this will not appear. The lower left and
right are extracted precursor and fragment ions at different CE.
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6 Perform Rapid Bulk Data Review

V A X 88 Targets 88 Suspects M Previous Sample | 10ppb ¥ & Next Sample 202 @ 43 . 201
Status Compound Name RT. R.T. Diff. Target lon Mass Accuri Mass Match Score  # of Verified lons  Final Conc. CAS® Lo
Butoxycarboxim 2877 0.052 223.0747 -4.2060 438 - 34681-23-7
Aminocarb 2816 0.003 209.1285 -0.5832 986 5 10.0379 2032-59-9
Omethoate 2847 0.003 2140297 -1.5391 a7.9 5 9.3601 1113-02-6
Aldoxycarb {Aldicarb Sulfo... 2877 0.028 223.0747 -4.2060 438 - 1646-88-4
Dinotefuran 2887 0.003 203.1139 -4.0299 95.6 2 9.5861 165252-70-0
Nitenpyram 2578 0.001 271.0956 0.9689 645 _ 115838 150824-47-8
Thiamethoxam 3.137 0.001 292.0266 -1.8683 96.6 4 10.6277 153719-23-4
Monocrotophos (Azodrin) 3.162 0.000 2240682 -2.2186 784 4 9.4820 6923-22-4
Flonicamid 3172 0.000 230.0536 -3.5668 56.3 3 120830 158062-67-0
Carbendazim [Azole) 3321 0.002 192.0768 -0.8247 928 4 10.7046 10605-21-7
Imidacloprid 3.420 0.003 256.0596 -0.3080 97.2 4 9.4516 138261-41-3
Flumetsulam 3.429 0.001 326.0518 -0.7804 98.0 5 10.0206 SES6T7-40-3
| T —— 2 acn nnnn acc nana nnacs ncn c na731 anAs ana e
< >
+ 5M Scan CID@0.0 ((2.777-2.894 min, 14 scans) 10ppb.d Aminocarb
‘E %102 129.p346 E x10° . 200[f285
a 9 2 (M4H)+
o o
8 3
7 4331127 25
[
2
5
4 15
313.0891
3 1
2 2101315
05 (M+H)+
1
HJ e | “ 2(;‘41-1313_9 2121363 213&1388 2141413
et Ehbb dl : W M MER (M)
0 200 400 600 800 1000 209 210 211 212 213 214
Mass-to-Charge (m/z) Mass-te-Charge (m/z)
+ SM Scan CID@20.0 ((2.777-2.894 min, 13 scans) 10ppb.d (Target/Qualifier ions ¢+ SM Scan CID@40.0 ((2.777-2.894 min, 13 scans) 10ppb.d (Target/Qualifier ions g
£ x0? 137.p83s £ w02 137.p83s
a 9 (0.L7) FE 0.7)
(o] o
8 8
7 7
3 ]
5 5
4 4
3 3
2 2
1 1
1] 100 200 300 400 500 600 700 800 S00 1000 V] 100 200 300 400 500 600 700 BOO 9S00 1000
Mass-to-Charge (m/z) Mass-to-Charge (m/z)

The columns in the screener can be moved around by dragging and dropping them in the table. These
can also be used to sort data. When an analyte is flagged for review, the aspect of the data that is an
outlier is also highlighted in orange.

e mmiim e e

v & >< 88 Tergets 88 Suspects  #\ Previous Sample  10ppb ~| % Next Sample 202 @ 49 201

Status Compound Mame RT. R.T. Diff. Target lon Mass Accuri Mass Match Score  # of Verified lons  Final Conc. CASH ~
Butoxycarbaoxim 2877 0.052 2230747 -4.2060 438 - 34681-23-7
Aminocarb 2816 0.003 209.1285 -0.5832 9B6 5 10,0379 2032-55-9
Omethoate 2847 0.003 2140297 -15391 979 5 9.3601 1113-02-6
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Perform Rapid Bulk Data Review

The top bar allows for filtering based on if the analyte is positive or needs review (or negative). It also

allows filtering based on Targets and Suspects. Targets are defined by this software as having a

calibration curve or not.

v ./i‘; >< B8 Targets 88 Suspects ™ Previo

Status Compound Name

Aminocarb
Omethoate

Dinotefuran

Thiamethoxam

hMrnarentanhns (Azadring

A new feature available in Quant 11 allows for promotion of compounds to green, orange, or red

RT.

2.816
2.847
2 887
3.137

3 1R7

through right-clicking. Right-click on the desired compound, then select Promote to Green, Promote to

Orange, or Promote to Red. To clear the promotion, right-click the compound, then select Clear

Promotion. This is useful when using either the ScreeningLC_Detailed or ScreeningLC_Summary PDF

Report Builder templates. Only Green compounds are reported with these templates.

]
v & X 88Tarqets 88$uspects

Status =~ Promoted = Compound Name

Promote to Green

Promote to Orange
Promote to Red

Clear Promotion

Previous Sample

Next Sample

Export Table...

' l!ll!llll_q
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/N Previous Sample | 100ppb.d

- Ethinfamanch muléavide

hyl-N-phenylurea)

CAS#
53380-22-6
61676-87-7
2275-23-2
135410-20-
148-79-8
2635-10-1
6988-21-2
60-51-5

101-42-8

Formula
C11H15NO3S
C12H14N2s
C8H18NO4PS2
7 C10H11CIN4
C10H7N3S
C11H15NO3s
C11H13NO4
C5H12NO3PS2
C9H12N20

RT.

3.431
3.517
3.611
3.676
3.629
3.431
3.792
3.812

3.857

R.T. Diff.
0.076
0.012
0.049
0.054
0.048
0.066
0.042

0.046
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Optimize Methods with the Update Retention Time Tool

This analysis method is not optimized for fragments or qualifiers. Fragments from the PCDL were added,
and it is assumed that in a complex matrix, one or more fragments will work well.

For routine deployment of a method, Agilent recommends that an R&D scientist optimize the method,
keeping the best fragment(s) for a given method and matrix and removing all others. An optimized
method is faster to process and easier to analyze than a method with many fragments. To optimize the
method, delete fragments that are not working from a spiked sample.

For target analytes, a standard is required. Suspect analytes (where no standard exists) should have more
than one fragment in the method.

The Retention Time Tool in the method editor has been updated to make visualizing the fragments easier.

Delete fragments to optimize the method

1 In method editor window, select Method > Update > Update Retention Times Tool.
Agilent MassHunter Quantitative Analysis (1

Method Setup Tasks v Advanced Tasks v  Duplicate Compounds
Manual Setup Tasks ¥ Update v
Outlier Setup Tasks v A Update Retention Times

Update Retention Times from ISTD

Average Retention Times

1od Table

gment: {  <All>

Shift Retention Time

Update Retention Times Tool

luantifier i\ Undate Qualifier Ratios
Name Average Qualifier Ratios
Update Mass Assignments

Trinta=sina

The Retention Times Tool displays in a new window. It shows the extracted chromatograms for the
precursor and fragment ions in the top panel. The lower left panel has the full spectrum at the selected
RT and the isotopic pattern in the lower right panel with the mass match score and theoretical
isotopes. This is useful for adding confidence to the RT assignment of the analyte.
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7 Optimize Methods with the Update Retention Time Tool

The top bar allows selection of the RT range displayed, the analyte, and the RT. It updates in the
method. Lenacil is selected in this example.

Update Retention Times Tool - o x
Entire Range  Extraction Range  Extraction Range 2§ ¢ [ Lenaci + > LeR/RghtRTDea: | 04 04 IAsetrT.

400000

350000
200000
250000
200000
150000
100000

50000

58 58 55 595 & 605 61 615 62 625 63 635 64 645 65 635 66 665 57 675 68 685 65 635 7 705 71 7M5 72 725 73 73

+SM Scan CID@0.0 ((6.586-6.586 min, 1 scans) 20ppb.d +SM Scan CID@0.0 ((6.586-6.586 min, 1 scans) 20ppb.d
TS Mot Seore-20008
550000 (M+Na) 15.5536
500000 (M+NH4)+: Score=47.2885
50000 0000 et
2351439
400000 80000
50000 o000
00000 w0
5000 oo o0 235}
200000 P
150000 6684365 30000
100000 20000 M+H)+ ZBQ‘ZDM
. g7
50000 j 47214 k 10000 | 235 ﬁrw ) Mot
i . l.. I w i S 0 A,
PR S T T R e T T B T R R T Y 1 I TR T

2 Use the top panel to select the ions displayed.

+ ESM [235.1441) Scan 20ppb.d

+ ESM [153.0659) Scan 20ppb.d
et i
+ ESM [82.0651) 5

35.0553) 5can 20ppb.d

n 20ppb.d

3 Todisplay the precursor ion only, un-check all but the blue ion (precursor).

+ESM (235

) Scan 20ppb.d

[ )

70000

60000
50000
40000
30000
20000

10000

68 68 69 695 7 705 71 715 72

4 Select two fragments, such as green (m/z 136.0393) and purple (m/z 153.0659), to display. In this

example, the purple ion has no nearby analytes and a stable signal. This is preferred to the green ion,
which has nearby interferences.

200000

175000
150000
125000
100000
75000
50000

25000
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7 Optimize Methods with the Update Retention Time Tool
Delete fragments to optimize the method

5 Under the Qualifier tab, delete the analytes that are not working well in the method.

— g e

Entire Range  Exraction Range _Extraction Rangex2 3 9 [Lensel = > Lem/RightAT Detta:
Method Tasks < %% | Method Table oo Etra Ringe Canaton Rang o < >
D New/Open Method Time Segment: { | <All> v/ > Compound: { | Lenacil - )l + ESM (235.1441) Scan 20ppb.d
4 Workflow [Quantifier 3| [ +sm(62.0651) Scan 20pp0.0
Name [ s [ Ttmmsion | Y= ————— =t
Torget Decommlution Setup & Fluometuron 1 233.08% Scan 400000
Sereening - 6C T
* Qualifier 000
Scsmng=1e Precursorion | Production | Tronsition 300000
4 Method Setup Tasks i 0.0000 720448 720484 -
0.0000 46.0651 46,0651
Compound Setup 0.0000 145.0260 145.0260 2000
Retention Time Setup = 0.0000 44.0495 44.0495 150000
ISTD Setup |Quantifier 100000
_ Concentration Setup Name [ 15 [ Tramsion | 5
| Qualifiersetup || = tenaci 123 1441 Scan T
| il SN e = =
Calibration Curve setup | (Qualifier 58 585 59 595 6 605 61 615 62 625 63 635 64 645 65 655 65 665 67 675 &
i Globals Setup Precusorion | Prlduction | Transition
1 0.0000 1360393 1360393 « SM Scan CID@OD (5.586-6.586 min, 1 scans) 20ppb.d +SM Scan CID@OD ((6586-6:5
4 save/Exit = 192382 (M=H)+: Score=09.0008
LD 0.0000 BAE] 620651 550000 e
@ validate oo 500000 (M+NH4)+: Score=47.2685
Name [ 18 [ Trnsition | 450000 30000 Lo
Save As... &{ Carboxin 1 2360740 Scan 400000 80000 >
: 350000 70000
Hox Compound Information
300000 60000
b Manual Setup Tasks 2ot AL inVvCIARLE S v
I 250000 & 50000 2359692
~ ESM (52 0651) Scan 20ppbd 50,1542
D Outlier Setup Tasks 2 10+ 200000 | 40000:
4 Advanced Tasks 5 - 6. 150000 6684365 S
1)+23920
Integration Parameters Setup 4 100000 20000 Ly "'7\ |
a1214 2
signal to Noise Setup o 50000 J 1000 | 2354apE).
b sl . i,
smoothing Setup 2 0 100 200 300 400 500 600 700 800 900 1000 234 23 238 2
1l Mass Extraction Setup

6 If more fragments are needed, or if incorrect fragments are deleted, add them back in from the PCDL.
Right-click the analyte and select Generate Qualifiers from Library — LC.

———| Fill Down
Cuantifier
Nam Reset Sort
E}'T Lenacil Arrange Compounds By 2
- |Qualifier
Prect New Compound
New Qualifier
L: Mew Calibration Level
Cluantifier
— Delete
MNarn
= Carboxin Duplicate Compounds

Compound Infi Swap Qualifier With Quantifier

2 @ T AL Senerate Qualfiers from Lbren 6C...
ESM (82.0651) Scan ! Generate Qualifiers from Library - LC ...
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Optimize Methods with the Update Retention Time Tool
Delete fragments to optimize the method

7 Add the PCDL to the table, then adjust the number of fragments.

Method from Library (Qualifiers) - LC x
Library:
D-\MassHunter\Data\MHQuant10.1 Training Data)\Pesticides_6546_Targets_RT.CDBE
Workflow:
Alllans hd
Cualifiers:

: Mumber of qualifiers to add:
[a]
!

Candidate ion ranking:
Most abundant hd
[ conc
8 Select OK.
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8 Build a Method with Q-RAI Data

1 Before starting, create a new batch and add samples as described in Create a Batch of Samples.

Add Samples ? x

Batch Folder: D:\MassHunter\Data'\MHQuant 10.1 Training Data‘\GRAIN

Sample
Group

* 10ppb_Broceoli_20190419_G-RAI_02.d | 10 ppb broccoli1 £/19/201912:49 PM

File name Mame Acq. Date-Time |

| Browse to Copy Samples... |

| Translate MSWS Samples... |

5 [ G

2 Build a targeted analysis method as described in Build a Targeted Analysis Method from PCDL.

The sample Method from Library - LC window below provides suggested parameters to set up the
method. See Build a Targeted Analysis Method from PCDL for more information on selecting
appropriate criteria.

Method from Library - LC x
Litrary:
D-\MassHunter\Data\MHQuant10.1 Training Data\Pesticides_6546_Targets_RT.CDB
Workflow:
Q-RAI -
Sample:

Sample path: {required for G-RAI workflow)

D-\MassHunter\DatalMHCQuant10.1 Training Data\QRAIN10ppb_Broccoli_2019041¢

[] Update BT from sample

Targets:

® All compounds
() Use compound list

CQualifiers:

Number of qualifiers to add:
e
=
Candidate ion ranking:
IViost abundant -
Species

(M+H)= Choose...

QK | | Cancel |

MassHunter Quantitative Analysis LC/Q-TOF Screener Method Development Using All lons and Q-RAIl Data 39



Build a Method with Q-RAI Data

The Method Table window below is an example of a Q-RAI data file. The Precursor lon is imported from the
PCLD, based on the species selected during method set up. The Transition shows the quadrupole bands

set in the acquisition method.

Method Table

Time Segment: | <All» ~ » Compound: ~ » ResetTable View
Quantifier |
Name TS Transition Scan Type Precursor lon ‘ Product lon Uncertainty |
Cycloate 1 216.1417 Scan Target 0.0000 216.1417 Relative

Qualifier ‘
Precursor lon Product lon Transition ‘ Rel. Resp. ‘ Uncertainty ‘ Area Sum ‘ Collision Energy | Collision Energy Delta ‘
2161417 56.0542 160-230 -» 55.0542 10.0 200 O 40.0 0.1
C 216.1417 83.0855 160-230 -- 83.0855 10.0 200 O 200 0.1
B 2161417 63.0263 160-230-» 63.0263 62 200 O 200 0.1
: 2161417 72.0444 160-230-» 72.0444 47 200 O 200 0.1

[ 1

Follow the above outlined sections to Create an LC Screener Method, apply it to the data, and analyze the
data using the LC Screener.
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